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All rights are reserved.  No part of this document may be reproduced or transmitted in any form or 
means electronic or mechanical including photocopying and recording or by any information 
storage or retrieval system except as may be permitted in writing by Civica Education Pty Ltd.  
  
Application for permission for use of copyright material, including permission to reproduce extracts 
in other published works, shall be made to the publishers.  Full acknowledgement of author, 
publisher and source must be given. 
  
Material is contained in this publication for which publishing permission has been sought and for 
which copyright is acknowledged. Permission to reproduce such material cannot be granted by the 
publishers and application must be made to the copyright holder. 
  
Microsoft, Windows and Excel are registered trademarks of Microsoft Corporation.  Visual 
Components is a trademark of OMNIS Software Limited.  Integris is a trademark of RM Plc. 
  
Because our policy is to improve our products and services continually, we may make changes 
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we cannot be held responsible for the consequences of any errors or omissions. 
  
Your comments are of great value to us in improving our computer systems, publications and 
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1 General Reports: Student Activities Report  
 

 
 
The settings used in the sample report. 
  



 
IntegrisAdminReportsManual 28-May-19 

Page 9 

© 2019 Civica Education Pty Ltd 

 

General Reports: Student Activities Report  
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2 General Reports: Activities Report 
 

 
 

 
 
The settings used in the sample report.
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General Reports: Activities Report 
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3 General Reports: Medication Report 
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4 General Reports: Medical Conditions 
Note: WA additionally includes the “Include Daily Management Plan” Option. 
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 Medical Conditions NT/NZ 
 

 
 
Medical Conditions – WA 
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5 General Reports: Medical Conditions Trained Staff (WA only) 
 

 
 
Settings used in this Report 
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6 General Reports: Medical Details 
Note: WA additionally includes the “Include Daily Management Plan” Option. 
 

 
 
The settings used in the sample report.



 
IntegrisAdminReportsManual 28-May-19 

Page 19 

© 2019 Civica Education Pty Ltd 

 

 Medical Details Report-NT/NZ 
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Medical Details Report-WA  
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7 General Reports: Doctor/Practice List 
 

 
 
The settings used in the sample report. 
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Doctor/Practice Report 
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8 General Reports: Dental Practice List 
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Dental Practice List Report 
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9 General Reports: Birthday Report 
 

 
 
The settings used in the sample report. 
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Birthday Report 
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10 General Reports: Students with No Address 
 

 
 
The settings used in the sample report. 
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Students with No Address 
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11 General Reports: Students and their Teaching Sets 
 

  
 
The settings used in the sample report 
.



 
IntegrisAdminReportsManual 28-May-19 

Page 30 

© 2019 Civica Education Pty Ltd 

 

Students and their Teaching Sets 
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12 General Reports: List of UDIs 
 

 
 
The settings used in the sample report.
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List of UDIs 
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13 General Reports: Health Care Conditions Review Date 
 

 
 
The settings used in the sample report. Having No Dates entered will default to include ALL Dates 
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Report Filtered to Asthma only 
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Roll Reports: Current Roll 
 

 
 
The settings used in the sample report. 
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Current Roll 
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14 Roll Reports: Current Roll with User Font Size 
 

 
 
The settings used in the sample report. Note that on this report, if a large font is chosen some 
fields may overlap. 
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Current Roll with User Font Size 
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15 Roll Reports: Former Students 
 

 
 
The settings used in the sample report. 
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Former Students 
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16 Roll Reports: Admissions   
 

 
 
The settings used in the sample report.



 
IntegrisAdminReportsManual 28-May-19 

Page 42 

© 2019 Civica Education Pty Ltd 

 

Admissions 
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17 Roll Reports: New Admissions to Current Roll 
 

 
 
The settings used in the sample report. 
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New Admissions to Current Roll 
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18 Roll Reports: Admissions or Leavers Report 
 

 
 
The settings used in the sample report. 
 
Note: The report can be configured to show only Indigenous, only non-indigenous or all students. 
A students’ Indigenous Status is displayed on the second line of student data, immediately beneath 
the Date of Birth field. The code ‘I’ is printed to indicate the student has indigenous status; no code 
is printed where the student is not indigenous. 
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Admissions or Leavers 
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19 Roll Reports: Standard Student List  

  
 
Note: The Age column on this report will display the age as at the date entered in the field ‘Show 
age as at’.   
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Report with Tick Box 
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20 Roll Reports: Student Address Details 
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21 Roll Reports: Parent/Guardian 1 Phone and Address 
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22 Roll Reports: Students with Temporary UPNs 
 

 
 
The settings used in the sample report. 
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Students with Temporary UPNs 
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23 Roll Reports: Students List Showing Current and Previous 
UPNs 

 

 
 
The settings used in the sample report. 
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Students List Showing Current and Previous UPNs 
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24 Roll Reports: Students with Siblings 
 

 
 
The settings used in the sample report. 
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Students with Siblings 
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25 Roll Reports: Year Lists 
 

 
 
The settings used in the sample report. 
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Year Lists 
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26 Roll Reports: Roll Count by Date 
 

 
 
Summarised by Year and Totals Only 
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Summarised by Form and Totals Only 
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27 Form Lists: Standard Form List 
 

 
 
The settings used in the sample report. 
 
Note: If the External Roll has been turned on (Control > Preferences > External Roll Active for 
Students), a checkbox for ‘Include External Roll’ will appear on this report window. 
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Standard Form List 
 

 



 
IntegrisAdminReportsManual 28-May-19 

Page 65 

© 2019 Civica Education Pty Ltd 

 

28 Form Lists: Form List Summary 
 

 
 
The settings used in the sample report. 
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29 Form Lists: House Form List  
 

 
 
The settings used in the sample report. 
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House Form List 
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30 Form Lists: Student Address Details 
 

 
 
The settings used in the sample report. 
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Student Address Details 
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31 Form Lists: Parent/Guardian 1 Phone and Address 
 

 
 
The settings used in the sample report. 
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Parent/Guardian 1 Phone and Address 
 

 



 
IntegrisAdminReportsManual 28-May-19 

Page 73 

© 2019 Civica Education Pty Ltd 

 

32 Form Lists: Student Information Sheets 
 

 
 
The settings used in the sample report. 
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Student Information Sheet (Page 1) 
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Student Information Sheet (Page 2) 
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Student Information Sheet (Page 3) 
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Student Information Sheet (Page 4) 
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33 Form Lists: Student Information Cards 
 

 
 
The settings used in the sample report. This Report will print three Student Information Cards per 
page. 
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Student Information Cards 
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34 Form Lists: Student Update Form 
 

 
 
The settings used in the sample report. 
 
Users can also elect to hide certain details, where there may be a requirement to keep details of 
particular parents, students or other contacts confidential. 
 
By clicking on Hide Details, the following details can be hidden in the report. When Other Student 
Contacts is changed to NO, another button, Hide Contacts, will display when you have selected a 
single student. By clicking on Hide Contacts, Individual Contacts can be selected to be hidden 
on the selected student’s Update Form. 
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If Other Student Contacts is changed to NO when running this Update Form for multiple students 
all other student contacts will be hidden. 
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Student Update Form 
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35 Form Lists: Student Photos 
 

 
 
The settings used in the sample report. 
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Student Photos 
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36 Form Lists: Dinner Money Register 

 
 
The settings used in the sample report. 
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Dinner Money Register 
 

 



 
IntegrisAdminReportsManual 28-May-19 

Page 89 

© 2019 Civica Education Pty Ltd 

 

37 Form Lists: Teaching Set List 

 
 
The settings used in the sample report. 
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Teaching Set List 
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38 Form Lists: Solos and Siblings 
 

 
 
The settings used in the sample report. 
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Solos and Siblings 
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39 Form Lists: Manual Register List 
 

 
 
The settings used in the sample report. 
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Manual Register List 
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40 Check Lists:  Check Lists 
 

 
 

 
 
The settings used in the sample report. 
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Check Lists 
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41 Check Lists: Form Check Lists 
 

 
 
The settings used in the sample report. 
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Form Check List 
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42 Check Lists: Group Check Lists 
 

 
 
The settings used in the sample report. 
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Group Check Lists 
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43 Check Lists: Weekly Check Lists 
 

 
 
The settings used in the sample report. 
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Weekly Check Lists 
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44 Check Lists: Form Weekly Checklists 
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Form Weekly Checklist Report 
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45 Graphs: Parameters Breakdown 
 

 
 
The settings used in the sample report. 
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Parameters Breakdown – graph 
 

 
 
 
Parameters Breakdown – view report data 
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46 Monitoring Reports: Reporting by Age 
 

 
 
The settings used in the sample report. 
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Reporting by Age 
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47 Monitoring Reports: Reporting by Gender 
 

 
 
The settings used in the sample report. 
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Reporting by Gender 
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48 Monitoring Reports: Personal Parameters 
 

 
 
The settings used in the sample report. 
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Personal Parameters 
 

 



 
IntegrisAdminReportsManual 28-May-19 

Page 113 

© 2019 Civica Education Pty Ltd 

 

49 Address Labels 
 
The following labels are available to be printed from this folder 
 

 Student Resident 

 Emergency 

 Family Mail 

 Parental Responsibility 

 All Contacts 

 Fees Billing 

 Student Address 

 Student Details 
 

 
 
The settings used in the sample report. 
 

Note: The following Standard Labels are available from the drop-down list: 

 

 

Note: Address labels are produced for each contact marked as a Family Mail Marker. 
Parent/Guardian and Other Contacts can be flagged as Family Mail Markers can be 
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Address Labels-Family Mail 
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Student Details 
 

 
 
The settings used in the report. 
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Address Labels-Student Details 
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50 Exports: RM Exchange 
The export reports are designed specifically to create export files in a .CSV format. These are 
placed in the Integris outbox by default 
 
The RM Exchange enables basic user data to be imported/exported between RM Maths, RM 
snapshot, and other RM applications. 
 

 
 
 
The report creates a RMXCHNGE.csv file in the directory shown in the Export File box 
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51 Exports: Teaching Group 
 

 
 
 
The report produces a TGEXPORT.CSV file in the Integris Outbox folder 
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52 Exports: EDWA Library Export 
 
 

 
 
This report produces a LibStud.CSV file which includes basic information such as: 

 Surname 

 First name 

 Address 

 Parental contact 

 Start Date 

 Birth date 
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53 Exports: Parent/Guardian Email Export 
 

 
 
This Report produces a .csv file that contains Parent/Guardian or Family Mail Marker email 
addresses, depending on the option selected. 
 
Email addresses can then be copied from the file and inserted to the “To” field in an email client, 
for example Outlook. 
 
There is an option (ticked by default) to produce a report showing students who do not have email 
addresses for their Parent/Guardian or Family Mail Markers within their student Record. 
 

Sample csv file 
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Exception Report (Student Records without a valid email address) 
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54 Staff Reports: Staff Car Registration List 
 

 
 
The settings used in the sample report. 
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Staff Car Registration List 
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55 Staff Reports: Staff Contracts List 
 

 
 
The settings used in the sample report. 
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Staff Contracts List Report 
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56 Staff Reports: Staff Emergency Report 
 

 
 
The settings used in the sample report. 
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Staff Emergency Report 
 

 



 
IntegrisAdminReportsManual 28-May-19 

Page 128 

© 2019 Civica Education Pty Ltd 

 

57 Staff Reports: Staff List 
 

 
 
The settings used in the sample report. 
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Staff List 
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58 Staff Reports: Staff Address List 
 

 
 
The settings used in the sample report. 
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Staff Address List 
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59 Staff Reports: Staff Record Card 

 
 
The settings used in the sample report. 
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Staff Record Card 
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60 Staff Reports: Address Labels 
 

 
 
The settings used in the sample report. 
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Staff Address Labels 
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61 Ad Hoc Reports 
Users select from a wide range of fields to include in the report. Headings, fonts and graphics are 
user-defined. 

Note: Refer to Section 24 of the Administration Manager Manual for instructions on how to 
create Ad-hoc reports. 

61.1 Fields 

The following fields are available in the Ad-hoc Reporting section of Administration Manager. 
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These fields are available on simple, normal, label and export ad-hoc reports. They are all 
available for inclusion in the report’s selection criteria. 
 

Northern Territory and New Zealand users will find some variation in these fields due to 
local customisation. 

 

Note: When selecting UDI fields where a Lookup option has been used, users will need to 
use the numerical value of the Lookup option rather than the text used when selecting 
specific criteria values, as shown below. 
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62 Ad Hoc Reports: Simple Report 
If you want to report on basic student information, this option will miss out some steps in the 
wizard. 
 

 
 
The settings used in the sample report. 
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Simple Ad Hoc Report 
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63 Ad Hoc Reports: Normal Report  
 

 
 
Will activate an additional window in the wizard to include additional information. See below.  
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‘Normal’ Ad Hoc Report showing Contacts 
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64 Ad Hoc Reports: Labels 
 

 
 
The user can select font sizes and page layout. Microsoft Word Mail merge is an alternative means 
of creating address labels. 
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Labels  

Example: Student Name Tags 
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65 Student Emergency Contacts  

This report is available through the Student Emergency Contact icon    at the top of 
the screen and the Emergency icon on the Admin sidebar.   
 

The report prints on one or two pages, depending on the amount of data that has been 
recorded in Student Details for the selected student. 
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66 WA Reports:  Introduction 
Integris has been pre-configured with a set of WA (WA Department of Education) Reports.  The 
WA Reports are located in a separate sidebar. 
 
This is a general introduction to some of the functions available in the WA Reports.  Sample 
reports are provided on the following pages.  
 

 
 
The system displays the WA Reports window. 

Users can also access WA Reports from the Profile Icon  on the top tool bar. 
 
 

 
 

 Click on the WA Reports folder to display a list of reports. A standard layout screen will appear 
on the right side of the window when a report is chosen. It provides users with a range of report 
settings from which to choose. 
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66.1 Layout Tab 

This tab enables users to 

 Select small (9 pt) or large (12 pt) font 

 Select students’ preferred names or legal names 

 Change the default title, if required 

 Enter report footer text, if required. 
 
Enter a main title for the report, or leave the default title as displayed. Enter a footer for the report, 
if required. If you have entered a default report footer in Control > Preferences > Reports, the 
default footer will print on reports unless a new footer is entered in the Reports window. 
 
Once settings in other tabs have been made, user can return to the Layout tab to check the report 
layout. 

  
Portrait Landscape 
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66.2 Sort Tab 

The Sort tab provides fields that can be dragged and dropped into a list.  
 

 
 
Specify a sort sequence, if required, by dragging the sort field of your choice into the Sort Field 
area. Alternatively, double click on the sort field on the left to select it.  To apply more than one sort 
field, double click on the other field(s) as required.  
The following example shows the sort order for a report sorted by Year and then by Form.  
 

 
 
If you apply a sort, you can also decide whether you want to include totals. You can have a total for 
each field. There is also the option to print each value of a field on a new page, e.g. each Year on 
a separate page. Place a tick in the appropriate check boxes in the Total and Page columns. 
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66.3 Select Tab 

This tab provides the options to select groups of students, e.g. by Year or by Group. 
 

 
 
Select the radio button for the required group. The following example shows three forms selected 
for printing. Hold the <Ctrl> key to select several groups.  
 

 
 

Use the Select All  button to select all the groups displayed in the pane. 
 

 
 

If you select the Student Find option , the New Query button is used for selecting 
search criteria in the Student Search window. The number of students selected will be displayed in 
the field beside the New Query button.  
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Alternatively, select a saved query from the drop-down list.  
 

  
 

66.4 Includes Tab 

This tab enables the user to select the fields to be printed on the report.  

 

Note that the Form Teacher(s) field is only available for selection if 

 Form is the first sort field selected in the Sort tab and 

 Form is the method of selecting students in the Select tab. 
 

 
 

Select the fields to be included in the report. The order in which fields on the right of this 
tab are selected will be the order in which the fields will be printed across the page. 
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66.4.1 Includes Tab > Checklist Reports 

The Standard Student Checklist and the House/Faction Checklist enable users to create 
checklist reports with user-defined columns and headings. 
 

 
 

Select the fields required on the report. To add checklist columns, place a tick next to a 
column label field and enter the column label. Tab to the Width field and enter the desired 
column width (in Cm). 
 
As additional fields are selected, the remaining available width is displayed at the bottom 
of the window. 
 

 
 
The user is warned if there is insufficient available width to add a field.  
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66.5 Checking the Report Layout 

When selections have been made in each of the tabs, return to the Layout tab to view the report’s 
page layout. If there are many fields (or wide fields) on the report, the layout will change from 
portrait to landscape. 
 

                      
Portrait                     Landscape 
 

Printing a Report 

When all selections have been made, click on the Print button to start the output process. The 
system displays the Report Destination window. Select the appropriate report destination. 
 
You may wish to print the report to screen, then close the report and make changes to the settings 
prior to printing to a printer. 
 

 
 
See the Integris Administration Manager Manual for more information on producing reports. 
 
User Access  
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See the Integris Administration Manager Manual for information on setting user access rights for 
reports and activating report security. 
 

67 WA Reports: Standard Student List 
Settings used in the following sample report. 
 

  
 

   

 
 
  



 
IntegrisAdminReportsManual 28-May-19 

Page 158 

© 2019 Civica Education Pty Ltd 

 

 
 WA Reports: Standard Student List 
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68 WA Reports: Standard Student Check List 
Settings used in the following sample report. 
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WA Reports: Standard Student Check List 
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69 WA Reports: House/Faction List 
Settings used in the following sample report. 
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WA Reports: House/Faction List 
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70 WA Reports: House/Faction Check List 
Settings used in the following sample report. 
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WA Reports: House/Faction Check List 
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71 WA Reports: House/Faction Summary Report  
Settings used in this sample report 
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72 WA Reports: House/Faction Listing  
Settings used in this sample report 
 

 
 
Settings Used in the Sample Report 
 
  



 
IntegrisAdminReportsManual 28-May-19 

Page 168 

© 2019 Civica Education Pty Ltd 
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73 WA Reports: Birthday Report 
Settings used in the following sample report. 
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WA Reports: Student Birthday Report 

 
 
Report Selecting Form 
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74 WA Reports: Student Update Form 
Settings used in the following sample report. The default notes can be edited. 
 
This report is designed to fit in an envelope with a window. A Student Update Form prints for each 
Family Mail Marker flagged. 
 

 
 

Notes: The “Include Siblings who are on the former roll” option will only be activated if the 
“Include siblings on the report” box is ticked. 

The option to Print each Student on a fresh sheet of paper will ensure different students’ 
details are not printed back to back. 

 
Schools have the options to Hide Details on a Student Update Form. Certain Information which 
may be sensitive between guardians can be hidden, including student address and contact 
numbers for Parent Guardian 1 or 2. 

 
Clicking on Hide Details reveals the screen below 
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Student Update Form 
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Student Update Form (Page 2) 
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Student Update Form (Page 3) 
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Note: This sample Student Update Form has been printed with student’s home address and 
contact number hidden. 
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75 WA Reports: Immunisation Report 
 

 
 
Settings used in the following sample report. 
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WA Reports: Immunisation Report 
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76 WA Reports: Students with the Same Address 
Settings used in the following sample report. 
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WA Reports: Students with the Same Address  
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77 WA Reports: Students for a Parent/Guardian 
Settings used in the following sample report. 
 

 Use New Query to find the required parent(s). 
 

 
 

 Select and load the query. 
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WA Reports: Student for a Parent/Guardian  
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78 WA Reports: Family Representative List 
Settings used in the following sample report. 
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WA Reports: Family Representative List 
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79 WA Reports: Student Profile Report 
 
Settings used in the following Report 
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IntegrisAdminReportsManual 28-May-19 

Page 186 

© 2019 Civica Education Pty Ltd 

 

80 WA Reports: Student Health Care Summary 

 
 
This is the report format of the Student Health Care Summary (Form 1) 
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81 WA Reports: Students with a Documented Plan 
 

 
 
This report allows schools to print out details of those students who are in Care of the Department 
of Child Protection DCP 
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82 WA Reports: Family Mail Marker List 
 

 
 
Settings used in the sample report. 
 
This Report will display all contacts for a student that are marked as a Family Mail Marker. An 
option to extract the data to a CSV file is also available. 
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CSV Data Extract Sample 
 

 


